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Basic Operations

This section is designed to get you started and help you set up FTD Mercury. You should read this 
section after you have installed your hardware. The following areas are covered:

» Starting and exiting FTD Mercury

» Getting to know FTD Mercury, including the FTD Mercury working environment and system 
navigation

» Setting up your printers

» Setting up your employees and passwords

» Backing up your data

» Performing daily, weekly, and monthly procedures

IMPORTANT For instructions on using the Store Setup Wizard (Configuration Wizard) that appears when you turn on 
your computer for the first time, please refer to the out-of-box instructions that were shipped with FTD 
Mercury.

Navigation
If you are a new Windows user, this section may help you adjust to your new system. Following are 
descriptions of mouse and keyboard navigation methods.

Mouse Navigation

Your mouse is used to select items on the screen. Throughout this reference guide, you are 
instructed to click, double-click, or right-click items. To click is to press and release your left mouse 
button one time quickly. To double-click is to click your left mouse button twice quickly. To right-
click is to push and release the right mouse button once quickly.
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Keyboard Navigation

FTDStartup and FTDShutdown
FTDStartup

When you restart you computer, the computer automatically runs FTDStartup, which starts all of 
your FTD Mercury services. These include FTD Mercury, communications software (CommPool), 
and FTD Reporter (the program that allows you to print from FTD Mercury). Icons for each of these 
services display in the system tray in your Windows taskbar.

You only have to run FTDStartup manually if you shut down your services using an FTD Shutdown. 

TASK To perform an FTD Startup:

On the Windows Start menu, point to All Programs, point to FTD Software, and click 
FTDStartup.

If you ever receive the message Unable to connect to the host server on the server PC or any 
of your client PCs, this means that the FTD Mercury services are not running on your server and you 
need to perform an FTDStartup.

FTDShutdown

FTDShutdown shuts down all of your FTD Mercury services, including the software, the CommPool 
(communications) and FTD Reporter (the program that is required to print from the FTD Mercury 
software). You should not run an FTDShutdown unless you are instructed to do so by FTD (for 
example, as part of an installation procedure). You are not able to use the software or send and 
receive messages if you perform an FTD Shutdown. After you perform an FTD Shutdown, you must 
perform an FTDStartup to start all of the services again.

TASK To perform an FTDShutdown:

On the Windows Start menu, point to All Programs, point to FTD Software, and click 
FTDShutdown.

Table 2-1: Keyboard Navigation

Key Use

Tab The TAB key is used to move your cursor from field to field. If you are a new Windows user, 
the TAB key most likely replaces the Enter key in previous programs you have used.

Shift+Tab Pressing the SHIFT and TAB keys simultaneously moves your cursor back one field.

F1 Pressing the F1 key while working in FTD Mercury displays a help page.

Ctrl+F1 Pressing the CTRL key and the F1 key simultaneously displays help for a particular field 
(when your cursor is in that field).

Ctrl+Tab Pressing the CTRL key and the TAB key simultaneously moves you to the next tab in the 
window (if you are in a window that has tabs).

Alt+letter Pressing the ALT key then the underlined letter on a menu, button, etc., activates the 
function on the menu, button, etc.

Esc The ESC key brings you back one screen.
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Logging In
NOTE If you are starting FTD Mercury for the first time, the System Login window appears automatically after 

you complete the Store Setup Wizard.

TASK To log in to FTD Mercury:

1 Double-click on the FTD Mercury icon on your desktop. The System Login window opens.
2 In the Login Name field, type your login name and press Tab. If you are logging in for the first 

time, type admin as the login name.
3 In the Password field, type your password. If you are logging in for the first time, type admin as 

the password. Asterisks (*****) appear to protect your password.
4 By default, your store name appears in the Store Name field. If you have multiple stores, click 

the arrow and select the name of the store for which you want to log in. 
5 Click Login.

If you are logging in for the first time, you may continue to use this login name and password until 
you assign yourself and each of your employees a login name and password in the system. For 
information on assigning passwords, see Employee Folder on page 24–50 for details.

IMPORTANT If you receive the message Unable to connect to the host server, you need to perform an 
FTDStartup procedure. See FTDStartup and FTDShutdown on page 2–2 for details.

System Login Window
When you first launch FTD Mercury, the System Login window appears. You must enter your login 
name and password for the selected store in order to start using FTD Mercury.

Connection Error Window
The Connection Error window displays when your computer cannot connect to the server. If you 
are working on a terminal that is connected to a main terminal, make sure that the main terminal is 
connected.

Allow the program a few moments to try to connect to the server. If the program cannot connect, 
call FTD Mercury support at 1-888-681-7911 for assistance. 

Setting the Date and Time
After you have installed and started up your system, check the time that displays in the lower right-
hand corner of your computer screen. The time must be correct so FTD Mercury can display the 
correct time when sending and receiving messages. If the time does not display correctly, you 
should set it.

TASK To set the date and time:

1 Double-click on the time displayed in the lower right corner of your screen.
2 When the Date and Time Properties window opens, click the select the current month.
3 Click the up and down arrows with your mouse to change the year to the current year.
4 In the right side of the window, select the hour indicator with your mouse and use the up and 

down arrows to set the hour. Repeat this procedure to set the minute, second, and AM/PM 
indicators.

5 Click the Time Zone tab. Click the down arrow and select the time zone in which your store is 
located.
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6 Click the check box at the bottom of the window to ensure the computer will automatically 
adjust its clock for daylight saving changes.

7 Click OK. 

FTD Mercury Main Menu Window
After you log in to FTD Mercury, the FTD Mercury Main Menu opens. This is the hub for all FTD 
Mercury functionality. 

Figure 2-1: FTD Mercury Main Menu

The FTD Mercury Main Menu has four button groupings, organized to help you access the most 
common commands quickly. The full suite of commands is available from the menu bar.

Main Functionality Functions
At the front center of the FTD Mercury Main Menu are six buttons corresponding to extremely 
common commands in FTD Mercury.

Table 2-2: Main Buttons

Command Description

Order Entry Opens the Order Entry window. You can also access this button by pressing O.

Point of Sale Opens the Point of Sale window. You can also access this button by pressing P.

What’s New Launches the What’s New PDF.

Designer Opens the Design Center window. You can also access this button by pressing G.
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Bookkeeping Functions

At the bottom center of the FTD Mercury Main Menu, five buttons relating to bookkeeping 
functions are grouped together.

Search Functions
At the top right of the FTD Mercury Main Menu, five search buttons are available. You can quickly 
execute any of these searches by pressing the number key corresponding to that search.

Delivery Opens Mercury Delivery. You can also access this button by pressing D.

Marketing Opens Mercury Marketing. You can also access this button by pressing K.

Table 2-3: Bookkeeping Buttons

Command Description

Receive Payment Opens the Receive Customer Payment On Account window. You can also access 
this button by pressing Y.

Accounting Opens Mercury Accounting. You can also access this button by pressing A.

Credit Cards Opens the Unsettled Credit Card Authorizations window. You can also access this 
button by pressing C.

Statements Opens the Generate Statements window. You can also access this button by 
pressing S.

Business Reports Opens an Explorer window to the Office Templates folder. You can then open the 
Mercury Forms folder and select the report you want to generate. You can also 
access this button by pressing B.

Table 2-4: Search Buttons

Command Description

Ticket Opens the Ticket Search window and automatically searches for tickets from 
today’s date and before. You can also access this button by pressing 1.

Message Opens Message Center and automatically searches for all messages that require 
attention. You can also access this button by pressing 2.

Florist Opens the Florist Search window. You can also access this button by pressing 3.

Customer Opens the Customer Search window. You can also access this button by pressing 
4.

Product Opens the Product Search window. You can also access this button by pressing 5.

Table 2-2: Main Buttons (cont.)

Command Description
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Other Functions

At the bottom left of the FTD Mercury Main Menu, there are two additional buttons (you can see 
the name of each button by hovering over the button with the mouse). These are less commonly 
used commands than others on the FTD Mercury Main Menu, but still tremendously valuable.

Menu Bar
At the top of the FTD Mercury Main Menu is a menu bar. The commands under each menu provide 
access to FTD Mercury’s features and functionality.

File Menu

The File menu consists of the following commands:

Table 2-5: Other Buttons

Button Description

Transmit Now Initiates a send and receive command with the Mercury Network. Normally, 
messages are sent every few minutes, but this command forces the send and 
receive to occur now.

Merc Tech U Opens an Internet Explorer browser window to the Merc Tech U Web site. This 
Web site contains information about FTD Mercury, including documentation, 
tips & tricks, and breaking news.

Table 2-6: File Menu Commands

Command Description

Logout Logs the current user out of FTD Mercury, closes the FTD Mercury Main Menu, 
and opens the System Login window.

New Customer Opens the Customer Detail Information window, from which you can add a new 
customer to your FTD Mercury database.

New Product Opens the Product Entry window, from which you can add a new product to your 
FTD Mercury databases.

Order Entry Opens the Order Entry window.

This command corresponds to the Order Entry button on the FTD Mercury Main 
Menu.

Point of Sale Opens the Point of Sale window.

This command corresponds to the Point of Sale button on the FTD Mercury Main 
Menu.

Exit Closes FTD Mercury.
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Search Menu

The Search menu consists of the following commands:

Mercury Message Menu

The Mercury Message menu consists of the following commands:

Table 2-7: Search Menu Commands

Command Description

Ticket Search Opens the Ticket Search window and automatically performs a search for tickets 
from today’s date and before.

This command corresponds to the Ticket Search button on the FTD Mercury 
Main Menu.

Message Search Opens the Message Center and automatically performs a search for messages 
that require your attention.

This command corresponds to the Message Search button on the FTD Mercury 
Main Menu.

Florist Search Opens the Florist Search window.

This command corresponds to the Florist Search button on the FTD Mercury 
Main Menu.

Customer Search Opens the Customer Search window.

This command corresponds to the Customer Search button on the FTD Mercury 
Main Menu.

Product Search Opens the Product Search window.

This command corresponds to the Product Search button on the FTD Mercury 
Main Menu.

Facility Search Opens the Facility Search window.

Employee Search Opens the Employee Search window.

Statement Search Opens the Statement Search window.

Credit Card Search Opens the Credit Card Search window.

Table 2-8: Mercury Message Menu Commands

Command Description

Ask (ASK) Opens the Create ASK Message window.

Answer (ANS) Opens the Create ANS Message window.

Cancel (CAN) Opens the Create CAN Message window.

Confirm (CON) Opens the Create CON Message window.

Delivery Confirmation 
(ANS)

Opens the Delivery Confirmation (ANS) Message window.

Deny (DEN) Opens the Create DEN Message window.

Forward (FOR) Opens the Create FOR Message window.

Reject (REJ) Opens the Create REJ Message window.

General (GEN) Opens the General Message Detail window.
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Management Menu

The Management menu consists of the following commands:

Adjust (ADJ) Opens the Adjustment Message (ADJ) window.

Rec Message List (REC) Opens the REC Message List window.

Resume (RES) Opens the Resume Message (RES) window.

Retrieval (RET) Opens the Retrieval Message (RET) window.

Suspend (SUS) Opens the Suspend Message (SUS) window.

Transmit Now Initiates a send and receive command with the Mercury Network. Normally, 
messages are sent every few minutes, but this command forces the send and 
receive to occur now.

This command corresponds to the Transmit Now button on the FTD Mercury 
Main Menu.

Table 2-9: Management Menu Commands

Command Description

Employee History Opens the Employee History Information window.

Employee Sales 
Summary

Opens the Employee Sales Summary window.

Reports and Templates Opens an Explorer window to the Office Templates folder. You can then open the 
Mercury Forms folder and select the report you want to generate.

This command corresponds to the Business Reports button on the FTD Mercury 
Main Menu.

Gift Card Activity Opens the Gift Card Activity window.

Credit/Debit Memo Opens the Credit/Debit Memo window.

POS Sales Entry Opens the POS Sales Entry window.

POS Session History Opens the POS Session History window.

Generate Statements Opens the Generate Statements window.

This command corresponds to the Statements button on the FTD Mercury Main 
Menu.

Receive Payment Opens the Receive Customer Payment On Account window.

This command corresponds to the Receive Payment button on the FTD Mercury 
Main Menu.

Accounting Opens Mercury Accounting.

This command corresponds to the Accounting button on the FTD Mercury Main 
Menu.

General Ledger Export Opens the General Ledger Export window.

GL Export History Opens the General Ledger Export History window.

Table 2-8: Mercury Message Menu Commands (cont.)

Command Description
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Credit Cards Menu

The Credit Cards menu consists of the following commands:

Wire Reconciliation Menu

The Wire Reconciliation menu consists of the following commands:

Tools Menu

The Tools menu consists of the following commands:

Table 2-10: Credit Cards Menu Commands

Command Description

Settlement Opens the Credit Card Settlement window.

Voice/Resend 
Authorization

Opens the Unsettled Credit Card Authorizations window with the View 
Unapproved parameter selected.

View Unsettled 
Authorizations

Opens the Unsettled Credit Card Authorizations window with the View 
Approved parameter selected.

This command corresponds to the Credit Cards button on the FTD Mercury Main 
Menu.

Manual Authorization Opens the Credit Card Authorization window.

Table 2-11: Wire Reconciliation Menu Commands

Command Description

Load Wire 
Reconciliation

Opens the Load Reconciliation File window, allowing you to perform wire 
reconciliation automatically.

Manual Wire 
Reconciliation

Opens the Manual Wire Reconciliation Filter window, allowing you to filter your 
manual reconciliation data.

Auto Reconciliation 
History

Opens the Auto Reconciliation History window.

Table 2-12: Tools Menu Commands

Command Description

Designer Opens the Designer Assignments window (also known as the Designer or Design 
Center).

This command corresponds to the Designer button on the FTD Mercury Main 
Menu.

Delivery Opens Mercury Delivery.

This command corresponds to the Delivery button on the FTD Mercury Main 
Menu.

Marketing Opens Mercury Marketing.

This command corresponds to the Marketing button on the FTD Mercury Main 
Menu.

Fax and Email Monitor Opens the Fax and Email Monitor window.

Doc Center Opens the FTD Document Center.
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Help Menu

The Help menu consists of the following commands:

Using the FTD Mercury Main Menu
The FTD Mercury Main Menu is keyboard accessible. You can press the Tab key on your keyboard to 
move between the buttons. When a button has focus, it is highlighted in yellow. When you press 
the Enter key on your keyboard, the currently selected button activates the same as if you clicked it 
with your mouse.

Additionally, buttons on the FTD Mercury Main Menu have keyboard shortcuts. The shortcut is the 
underlined letter in the button name. When you press the corresponding key on your keyboard, the 
button activates. For example, if you press the R key on your keyboard, the Order Entry window 
opens. For the searches, press the number (displayed in the magnifying glass in the icon).

If you want to access menu bar commands, press the Alt key and the underlined key 
simultaneously to open the menu. You can then either use the arrow keys to move up and down 
the menu, or press the underlined key for the command you want to access. For example, if you 
wanted to open the FTD Mercury Configuration window (accessible from the Settings command 
under the Tools menu), you could press ALT+L and then press S.

Merge Customers Opens the Customer Merge window, from which you can merge duplicate 
customer accounts into a single account.

Purge Customers Opens the Purge Customers window, from which you can purge inactive 
customers from your FTD Mercury database.

Settings Opens the FTD Mercury Configuration window.

Printer Form Settings Opens the Printer Form Settings window.

Change Password Opens the FTD Mercury Server Password window, allowing you to change your 
password.

Reset POS Client 
Configuration

Unregisters this computer as a Point of Sale client. Do not use this command 
unless directed to by someone from the Mercury Technology Assistance Center.

Mercury 
Administration

Opens Mercury Administration, from which you can change many global 
configurations for FTD Mercury.

Table 2-13: Help Menu Commands

Command Description

Contents Launches FTD Mercury online help.

Merc Tech U Opens an Internet Explorer browser window to the Merc Tech U Web site. This 
Web site contains information about FTD Mercury, including documentation, 
tips & tricks, and breaking news.

This command corresponds to the Mec Tech U button on the FTD Mercury Main 
Menu.

License Agreement Opens the Software License window and displays the FTD Mercury license 
agreement.

About FTD Mercury Opens the About window and displays information about the FTD Mercury 
version and other associated software information.

Table 2-12: Tools Menu Commands (cont.)

Command Description
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Exiting FTD Mercury
If you want to exit FTD Mercury, you may do so by clicking Exit on the File menu. Keep in mind that 
you may minimize the program instead by clicking the minimize button in the upper-right corner 
of the window. At the end of the day, there is no need to exit the program or turn off the computer.

Address Check Window
The Address Check window appears if FTD Mercury does not understand the address that you 
entered in an address field. This does not necessarily mean that the address is wrong; check the 
information in the window and click Save.

Following is an example of how the address information should appear in this window:

Street: 123 Main Street Apt 4
City: Long Grove
State/Province: IL
ZIP/Postal Code: 60047 

Note Entry Window
In many places in FTD Mercury, you can add notes (such as to an order). Notes are not displayed 
when invoices, statements, etc. are printed. Use the Notes window to add additional information to 
the window. When information is saved in this window, a red check mark will appear over the Notes 
button.

TASK To enter notes in the Note Entry window:

1 If you want today’s date to display in the note, click Timestamp.
2 Type your note text.
3 Click Save. 

Setting Up Your Printers
After connecting your printers, you must set up your printer routing and decide which printer you 
want to print messages, and which printer you want to use for reports. 

FTD Mercury automatically detects all printers connected to your system through the FTD Reporter, 

which is indicated by the  icon located in the lower right-hand corner of your screen.

Checking Your Windows Default Printer
Your Windows default printer is the printer that Windows uses to print all print jobs outside of your 
FTD Mercury software. Once you have installed FTD Mercury, it is suggested that you check your 
system to make sure your default printer is correct.

TASK To check your Windows default printer or to make changes to it:

1 On the Windows Start menu, click Printers and Faxes. The Printers and Faxes window opens.
2 Printers that Windows has detected are listed in this window. The default printer has a check 

mark next to the printer name. If the printer you want to use as your default Windows printer 
does not have the check mark next to it, right-click on the printer and click Set as Default 
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Printer. The check mark will be put on the printer you just clicked on, denoting it as the new 
default printer.

3 Close the Printers and Faxes window by clicking the Close button ( ) in the title bar.

Setting Up Your Reports Printer
Your reports printer is used to print all marketing materials (letters, envelopes, and so on), reports, 
and customer statements that you create using your FTD Mercury software.

TASK To set up your reports printer:

1 Double-click on the FTD Mercury icon.
2 Log in to FTD Mercury.
3 On the Tools menu, click Printer Form Settings.
4 From the Store Name list, select your store.
5 In the General Printing row, in the Printer Selection column, select the printer you want to use 

for printing your store reports and customer statements. In the Tray column, select the printing 
tray for this printer.

6 Click Save.

Setting Up Your Mercury Message Printer
You can have a separate printer to print your incoming and outgoing Mercury messages. The 
Mercury Administration program allows you to specify for each incoming or outgoing message 
type if you want the message to print, the number of copies to print, and indicate which printer and 
tray you want the print job to be sent. For more information, see Printer Routing Screen on page 
24–79.

Printer Form Settings Window
The Printer Form Settings window allows you to configure the printers and trays associated with 
each form on a store-by-store basis. You need to configure printer form settings on each FTD 
Mercury system where you will enter customer orders.

Figure 2-2: Printer Form Settings Window

Each form type is listed in the Form column. For each form, you can select the printer you want to 
use for that form, and the tray on that printer. All printers available on the computer are available 
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for selection, including any network printers you have already set up using the Add Printer Wizard. 
(See Connecting to Network Printers on page 2–13 for details on setting up network printers.) 

Setting Up Your Printers and Form Selections
You use the Printer Form Settings window to configure the printers and trays associated with each 
form on a store-by-store basis, and on a per-client basis. You need to set this up on each FTD 
Mercury system where you will enter customer orders. All printers available on the system are 
available from this window, including network printers.

TASK To configure the printers each form prints on for a store:

1 In FTD Mercury, on the Tools menu, click Printer Form Settings. The Printer Form Settings 
window opens.

2 From the Store Name list, select the store for which you are configuring forms.
3 Locate the form you are configuring in the Form column. Click in the corresponding cell in the 

Printer Selection column to display an arrow. Click the arrow to display a list of available 
printers, and select the printer where you want this form to be printed.

4 In the corresponding Tray column, click and select the tray on the selected printer which 
contains the appropriate paper for this form.

5 Repeat steps 3 and 4 for any additional forms you want to configure.
6 Click Save.

IMPORTANT If you have multiple stores, you need to repeat this procedure for each store.

You can configure the number of forms printed for transactions from the Default Form Printing 
screen in Mercury Administration. See Default Form Printing Screen on page 24–81 for details.

Connecting to Network Printers
If you have a network printer that you want to use on clients for printing specific forms, you need to 
configure your system to connect to the printer.

TASK To add a network printer to your system:

1 On the Windows Start menu, click Printers and Faxes. 
2 In the Printers and Faxes window, under Printer Tasks, click Add a Printer. The Add Printer 

Wizard opens. 
3 Follow the prompts in the wizard, making sure you are configuring a network printer. 

When you are finished, the network printer appears on your system the same way as local printers 
do and will be accessible in the Printer Form Settings window in FTD Mercury.

Receiving Orders and Messages
Your system is set up to print one copy of an order or message to your default printer when it is 
received. You may change your system settings so that a message pops up on your screen when an 
order is received, or you can set an alarm to sound as well (change these settings using the Printer 
Routing screen in Mercury Administration). After a message is received by FTD Mercury, you can 
then attach the incoming order in Order Entry or Point of Sale and process the order.

Orders received over the telephone can be reported using the Rec Message List. 
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Setting Up Your Employees and Passwords
When you are set up in FTD Mercury, it is strongly suggested that you add your employees to the 
computer’s database. When you add employees through the Mercury Administration program, you 
assign passwords and ID numbers (for logging into the system), maintain employee security, and 
keep personal information in the system. For information on entering and maintaining employee 
records, see Employee Folder on page 24–50.

Backing Up Your Data
You can use locally connected devices, such as local hard drives, Iomega Zip drives, or USB thumb 
drives as backup devices for your FTD Mercury data. A backup of the server is performed 
automatically each morning at 3:00 A.M. Your server must be turned on for the backup to run, and 
your backup device must be ready (meaning if you are using a Zip drive, the Zip disk must be in the 
drive or if you are using a thumb drive, it must be plugged in to the USB port).

TIP You can purchase USB thumb drives from FTD. Contact FTD Technology Sales at 1-800-767-3222.

Your FTD Mercury data is compressed (in a .zip file format) and stored on your backup device. A 
thumb drive or Zip disk can handle several days’ worth of backups. When a ZIP disk gets full, the 
oldest data is automatically removed. In most cases, thumb drives and external hard drives will not 
fill up from backups. Typically, you have between 3 and 14 days worth of backups stored before the 
oldest backup is overwritten.

IMPORTANT If you want to add a new backup device, or if you want to configure the number of backups to keep on a 
device, contact the Mercury Technology Assistance Center at 1-888-309-2244 for assistance.

To protect yourself from losing data, you may want to rotate Zip disks every day, or alternate thumb 
drives each week. For optimal security and peace of mind, you may want to store backups off site 
periodically.

If you use a Zip drive for backup, you can purchase your own Zip disks to use in your Zip drive. You 
can purchase Zip disks at any office supply store. Make sure that you buy the disks labeled as 
“250M” or “750M.” 100M disks are not compatible with your Iomega Zip Drive.

IMPORTANT To restore data from a backup device, please call the Mercury Technology Assistance Center at 1-888-
309-2244.

Daily/Weekly/Monthly Checklists
You should run certain procedures on a regular basis to keep your shop running smoothly. For 
example, if you have Point of Sale you have to set an opening balance at the beginning of the day, 
and then close the cash drawer at the end of the day. To get you started, this section contains a 
recommended list of procedures that you should complete on a daily, weekly, and monthly basis. 

Daily Checklist

At the beginning of the day...
Check that your automatic backup from last night was completed.
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Remove your backup media (Zip disk or USB thumb drive) and store it in a safe place (ideally 
offsite).

Replace your backup media (either a different Zip disk or USB thumb drive) on your server. As a 
best practice, you should alternate between two or more Zip disks or USB thumb drives and 
store the ones not being used for backup that night offsite. You can purchase additional USB 
thumb drives from FTD.

TIP You can purchase USB thumb drives from FTD. Contact FTD Technology Sales at 1-800-767-3222.

Set the opening balance for each Point of Sale terminal. See Setting the Opening Balance on 
page 11–3 for details.

Daily Procedures
It is highly recommended that you complete each of these procedures on a daily basis.

Use Ticket Search to check for pending orders, particularly orders that are pending due to credit 
card authorization. See Searching for Tickets on page 9–47 for details.
Check to see if you have incomplete orders and process them. See Searching for Tickets on 
page 9–47 for details.
Open Order Entry or Point of Sale, click Message Center, and attach incoming orders (by 
double-clicking on them). Unattached orders appear in green text. See Attaching Incoming 
Orders on page 9–22 for details.
Check for any credit card errors or declined credit card transactions.  See Handling Unsettled 
Credit Card Authorizations on page 13–12 for details.

At the end of the day…

Verify all incoming wire orders have been attached. See Attaching Incoming Orders on page 
9–22 for details.
Verify all orders for the day have been completed. Look at the Dashboard for a quick glance of 
what may remain to be done, and perform a Ticket Search for tickets with statuses of pending, 
incomplete, or filed. See Dashboard on page 25–1.
Ensure all orders have been marked as Designed in Design Center. See Design Center on page 
12–1.
For Mercury Delivery users, verify all orders have been marked as delivered. See Mercury 
Delivery on page 14–1.
Balance your cash drawers and close your Point of Sale systems by using Z-out transactions. 
When you perform a Z-out, FTD Mercury automatically performs an X-Out transaction first, 
allowing you to find errors and correct them prior to finalizing the Z-out transaction. See Z-Out 
Transactions on page 11–7.

TIP To help balance a cash drawer, perform a Ticket Search for completed orders. Verify that sales were 
entered correctly. Common issues that can cause the cash drawer to be out of balance include cash sales 
being completed in Order Entry instead of Point of Sale, and payments on accounts made from the FTD 
Mercury Main Menu instead of  Point of Sale (if you are putting money in the cash drawer, you should use 
Point of Sale).

Print the Credit Card Settlement History report for today. See Credit Card Settlement History 
Report on page 19–16.
Prepare your bank deposit.
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Run the Balance Report using the Balance Wizard in Mercury Accounting. Print any pages you 
need for your records. The Balance Wizard (Exporting to QuickBooks) on page 20–15.
Double-check your backup media (Zip disk or USB thumb drive) in place for your server.

Weekly Checklist
The following items may be completed at any time. However, it is suggested that they be done on a 
weekly basis.

Report phoned-in Mercury Orders to FTD by sending REC messages.
Print an Orders Filled report for other wire services.
Run a Symantec AntiVirus Live Update.

TASK To run a Symantec AntiVirus Live Update:

1 On the Windows Start menu, point to All Programs, point to Symantec Client Security, and 
click Symantec AntiVirus.

2 Click Live Update.
3 Follow the on-screen instructions to update your virus definitions.

Monthly Checklist
You should perform the following tasks on a monthly basis:

Print the Aged Analysis report (you should also save an electronic copy of it). Proof the report to 
ensure it is accurate, and make any necessary corrections to accounts. See Aged Analysis 
Reports on page 19–7.
Generate customer statements. See Generating Statements on page 18–7 for detailed 
instructions.
When you receive your Combined Report, perform wire reconciliation. See Wire Service 
Reconciliation on page 17–1 for details.
Print the Sales Tax report. See Sales Tax Report on page 19–56.
Print the Sales Summary report. See Sales Summary Report on page 19–50. 
Print any other applicable reports.
Complete a General Ledger export. If you use the Accounting module, see The Balance Wizard 
(Exporting to QuickBooks) on page 20–15. If you use the legacy General Ledger Export feature, 
see Exporting the General Ledger File on page 21–4.
Run a Windows Update. Running a Windows Update monthly keeps your system up-to-date 
and helps prevent viruses from infecting your computer.

TASK To run a Windows Update:

1 On the Windows Start menu, point to All Programs, and click Windows Update.
2 On the Microsoft Web site, follow instructions to update Windows.

Configuring Your System
TASK To configure general system preferences:

1 On the Tools menu, click Settings. The FTD Mercury Configuration window opens. (See FTD 
Mercury Configuration Window on page 2–17 for a detailed description of all options.)

2 Set options as necessary.
3 Click Save.
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FTD Mercury Configuration Window
The FTD Mercury Configuration window allows you to set client-level preferences in FTD Mercury.

Figure 2-3: FTD Mercury Configuration Windows

The following options are available in the FTD Mercury Configuration window:

Table 2-14: FTD Mercury Configuration Window Options

Option Description

Prompt before sending a 
message or saving 
information

When checked, you receive the message “Are you ready to send this order or 
message” before sending an order or message.

Prompt before escaping 
from a window

When checked, you receive the message “Do you want to continue and lose 
what has been entered?” when closing a window without saving.
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When you finish making changes in this window, click Save.

Display Dashboard When checked, this option will automatically open the Dashboard when FTD 
Mercury starts.

Prompt for referral code 
before saving

When this option is checked, you receive the following message in Order 
Entry and Point of Sale if you attempt to save the order with the Referral 
Code field blank: “A marketing referral code was not assigned to this order. 
Do you still wish to complete this order?” 

Prompt for occasion code 
before saving

When this option is selected, the occasion code in Order Entry and Point of 
Sale is by default blank. The employee must select an Occasion Code prior 
to completing the order. If this option is not selected, the Occasion Code 
list defaults to Other.

Enable Address 
Verification Override

When you select this option, the Verify check box is displayed for recipient 
addresses in Order Entry and Point of Sale (allowing you to override address 
verification when entering orders on an order-by-order basis).

Process Debit Card in POS Applies only to Point of Sale systems licensed for debit card processing 
within FTD Mercury (and is only availble for Canadian systems). Select this 
option if you want to enable debit card processing via a PIN pad in Point of 
Sale. If you do not enable this, the PIN pad will not function.

Automatically Apply 
Customer Discounts

(Only applies if you use credit/debit memos). If there is a discount on a 
customer account and you want that discount applied automatically when 
the customer is selected, make sure that this option is checked. If you leave 
this option unchecked, then you will have to enter the discount manually.

Enter Key Functions as 
Save Button

(Only applies if you use credit/debit memos). If this option is checked, this 
means that if you press the Enter key while you are in the product grid, you 
automatically save the credit/debit memo. If you leave this option 
unchecked, then product information displays when you press the Enter key 
while you are in the product grid.

Receive Payment dialog 
opened in Batch Mode

When checked, the Receive Payment window opens in “Batch Mode.” Batch 
mode makes the window stay open after you click the Complete button so 
that you can enter several payments (without having to re-access the 
window each time). If you would NOT like the window to open in batch 
mode, make sure this option is unchecked.

Prompt before changing a 
close address match

This option is only valid if you have Address Verification. When this option is 
checked, the system first prompts you before changing an address to a close 
match (for example, a misspelled street name or changing “100 Main St” to 
“100 N Main Street”). If this option is unchecked, you are not prompted first if 
the system finds an address that is close to the address that you entered.

Prompt for customer email 
address before saving

When this option is checked, the system asks “Would you like to enter an 
email address for this customer?” upon saving if you do not enter an email 
address for a new customer in the Customer Detail Information window.

Automatically display 
Customer Notes

If you select this option, if you are entering or opening an order for a 
customer with associated notes in Order Entry or Point of Sale, the Notes 
window will automatically open.

Table 2-14: FTD Mercury Configuration Window Options (cont.)

Option Description
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Software License Window
The Software License window opens when you select License Agreement from the Help menu.

Figure 2-4: Software License Window

Carefully read the license agreement in this window. To read the entire license agreement, click the 
Page Down button each time you are ready to read the next page. When you reach the end of the 
agreement, the Accept button will become active. Click this button to start your FTD Mercury 
software.

If do not want to see this license agreement window again, ensure the Show this screen next time 
box is not checked.

If you do not agree with the terms of the license agreement, click Decline. The software will not 
start. Contact the FTD Sales Department at 1-800-669-1000 to discuss the terms of the license 
agreement.

About Window
The About window is used to view your system’s version number and copyright information.

Click Close to close the window. 
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Figure 2-5: About Window

Video Chat
If you have a Logitech QuickCam Orbit AF camera, you can use it for video chat in conjunction with 
SightSpeed. This functionality allows you to chat in real time with other video-chat enabled florists 
to discuss designs, answer order questions, or otherwise build relationships. You can also use it to 
chat with FTD personnel. For more information about video chat on FTD Mercury systems, contact 
FTD Mercury Technology Sales at 1-800-767-3222 or email TechSales@FTDi.com.

mailto:TechSales@FTDi.com

